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C H A P T E R

Chapter 1 INTRODUCTION

General Information
RasterMAPPER™ has three main functions:

• Create a map which defines the relationship between pixels on the video source 
(typically a computer screen) and the actual Element Labs fixtures. After creating the 
map in RasterMAPPER it is downloaded and stored on the processor.

• Control and adjust the processor as needed.

• Create patterns for use with the C1 processor.
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Terminology
• EL – Element Labs 

• C1 – Versa DRIVE C1 video processor

• D2 – Versa DRIVE D2 video processor

• RM – RasterMAPPER software

• Map – A map that defines the assignment of incoming video pixels to outgoing Versa 
DRIVE pixels. The map is a graphical tool used to create the actual Pixel List.

• Pixel List – a list of “mapped” pixels that is sent from RM to the D2.

• Pattern – A sequence of frames played back through the Versa system. Usually this 
refers to a pattern created for playback on the C1.

• CF – Compact Flash card used on the C1.

• Screen Pixel – A single pixel on the computer monitor that RM is running on.

• Work Grid Pixel – A single square on the work grid – it represents a fixture pixel in 
the real world – its size varies depending on the zoom level.

• Fixture Pixel – one pixel in an Element Labs LED fixture. For example – a standard 
Versa TUBE has 16 pixels inside.

• Scan Order – The physical wiring of the pixels inside an LED fixture. This, combined 
with the fixtures origin, is required to generate the pixel list in the proper order.

• D2 Output / Port – Any of the four serial data outputs (A, B, C, or D) on the back of the 
D2.
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System Requirements
• Microsoft Windows® XP

• Mac OS X v10.4 (or higher)

• 1024 x 768 display (or larger)

• 10 MB of Disk Space Minimum

• A serial port (RS232) is required to connect the PC to a D2 Processor.

• A USB or RS232 to RS485 adapter is required to connect multiple D2 Processors 
simultaneously.

• A USB to RS232 adaptor is required to connect RasterMAPPER to the D2 Processor 
under Mac OS X

Adobe® Reader® must be installed on your PC in order to use the RasterMAPPER Help menu 
item. Adobe® Reader® can be downloaded from www.adobe.com/products/acrobat/
readstep2.html.

Installation
Follow the steps below to install and run RasterMAPPER.

N O T E The downloaded .ZIP files must be extracted to the same folder to run properly.

Windows
1. Download RasterMAPPER software for Windows from the Element Labs website (http://

www.elementlabs.com/support.
2. Extract/un-zip the files to the same folder.
3. Double-click the file named RasterMAPPER.exe.

Macintosh
1. Download RasterMAPPER software for Mac OS X from the Element Labs website (http://

www.elementlabs.com/support.
2. Extract/un-zip the files to the same folder.
3. Double-click the file named RasterMAPPER.
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Quick Start
The following example shows the basic steps required to create a pixel map for a system of eight 
10x10 Versa TILE panels arranged in a wall that is two meters high and four meters wide:

1. Open a new document and make sure that you are in Pixel Map mode.
2. Choose a fixture from the Fixture Select drop-down menu (i.e. Versa TILE 10x10).
3. Click in the grid area to add fixtures.
4. Select the Sequence tab, select fixtures and press the  button, and assign the 

eight fixtures to addresses 1 through 8 using the   tool.

5. For the D2 processor, go to the Processor Control tab and connect to the drive. 
6. Return to the Pixel Map, Pixel List tab. The pixel list is generated automatically.
7. Press  to upload the pixel list to the D2 processor.
8. Test to confirm everything is working properly.
9. Go to the Programming tab.
10.Use the Insert and Add buttons to add media files to the list (the compressed/encoded 

media files may be imported only if the appropriate codec is installed on the computer).
11.Preview the pattern by using the Play  button.
12.Export the pattern in the .CFF format. Copy that file to a Compact Flash card for use in a 

C1. The file should have a 3 number prefix that is the pattern ID number on the C1 proces-
sor (i.e. 012_fire.cff ).
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RasterMAPPER Basic Workflow
The flowchart below shows the basic RasterMAPPER workflow.
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File Formats
RasterMAPPER uses the following file formats

.MAP
In the Pixel Map mode, map files are saved as a .MAP file. A .MAP file includes the fixture map, 
sequence information, and any custom user-defined fixtures created for that map.
.PTN
In Programming mode, the list of .AVI and .BMP items can be saved as a .PTN file. Note that 
.MAP and .PTN files are independent; you can mix and match them while using RM.
.VDC
For Versa DRIVE D2, when in Processor Control mode, a .VDC file saves all of the control 
parameters in the “Connection Settings” area and the “Output” area.
.LST
In the Pixel List tab, you can save (and open) the pixel list as an .LST file
.GWB
In the Group White Balance area of the Processor Control tab, you can save (and open) a list 
of pixels and values as a .GWB file. 
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General Information
RasterMAPPER allows you to open existing data files directly from your Desktop or any folder by 
simply double-clicking them. Also you can open files in standard way using Open menu 

command (or a  button).

RasterMAPPER Help
Windows: In order to get the RasterMAPPER Help menu item to work, the file RMHelp.pdf (this 
manual) must be in the same folder as the RasterMAPPER program file. If you move or delete this 
file, RasterMAPPER will not be able to find it.

Mac: In order to get the RasterMAPPER Help menu item to work, the file RMHelp.pdf (this 
manual) must be in the Resources folder inside RasterMAPPER.app bundle. This is only visible 
when you control+click on the RasterMAPPER application file and choose “Show Package 
Contents” from the contextual menu.

Adobe® Reader® must be installed on your PC in order to use the RasterMAPPER Help menu 
item. Reader can be downloaded from www.adobe.com/products/acrobat/readstep2.html.

Splash
When the RasterMAPPER application is started, the following splash screen is displayed. The 
splash screen contains the RasterMAPPER licensing information. To proceed, you must agree 
with the terms of the license.
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Quick Start
On first run, after the splash screen, RM displays the dialog box shown below. You have the 
option to continue to show the dialog every time the application is launched via the check box 
at the bottom. This dialog is also available through a menu item (see Help menu, p. 1-10 for 
more details).

Menus
RasterMAPPER has 3 menus: File, Edit and Help.

File menu

The File menu options include New, Open, Save, Save As, Revert, Page Setup, Print and Exit. 
The three commonly used menu commands for opening and saving files are duplicated as 
buttons: (from left to right) New, Open, Save.

Select Save As to save the changed data to another file/folder. Select Revert to revert your 
changes and get back to the initial state.
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N O T E S The File menu items: Open, Save, Save As, Revert are mode-dependant.
If Pixel Map mode is active, these items correspond to the .MAP files
If Programming mode is active, these items correspond to the .PTN files
If Processor Control mode is active and Versa DRIVE D2 processor is selected, these items 
correspond to the .VDC files

Page Setup gives you the standard dialog box to setup the page for printing. Print should be 
used to print out the work grid from any of the four tabs that show the grid:

• Pixel Map/Fixture Info

• Pixel Map/Sequence

• Pixel Map/Pixel List

• Programming

N O T E For all printing, the current view of the workgrid is what is printed. This means the current view 
at the current Zoom Level, including the background image and port/sequence/address info if 
selected – will be printed.

Select Exit to quit RasterMAPPER.

Tip: keyboard shortcuts are given for most of the menu commands.

Edit menu

The Edit menu items include Undo, Redo, Cut, Copy, Paste, Clear, Group, Ungroup, Duplicate, 
Duplicate Array, Flip, Select All.

The Cut, Copy, Paste, Undo, Redo items are duplicated as buttons: (from left to right) Cut, 
Copy, Paste, Undo, Redo.

Using Undo/Redo you can go back and forth between all the changes you made after opening 
the file.
RasterMAPPER™ User’s Guide 1-9



 Chapter 1
Introduction
Cut/Copy/Paste in the Pixel Map mode work according to standard conventions on either 
single fixture, multiple fixtures, or a group (see Selecting Fixtures, p. 2-12, Grouping/Ungrouping 
fixtures, p. 2-7, and Selecting Fixtures, p. 2-12). 

When a fixture is Cut, the sequence (see Sequence Tab , p. 2-12 for more details on sequences) is 
modified according to the same rules as if it was deleted. When a fixture is Pasted, the sequence 
is modified in the same way as if a fixture was inserted into a new location (as described in the 
“Sequence” section below).

In Pixel Map mode, Clear allows you to delete the selected fixtures or fixture groups. See 
Deleting Fixtures (p. 2-6) for more details on fixture deletion.

Using Group/Ungroup in Pixel Map mode fixtures may be grouped/ungrouped. See Grouping/
Ungrouping fixtures (p. 2-7) for more information about groups.

Using Flip in Pixel Map mode fixtures may be flipped (see Rotating Fixtures — Flip, p. 2-7 for 
more information on flip)

Using Select All in Pixel Map mode all the fixtures on the Work Grid may be selected (see 
Selecting/Deselecting fixtures, p. 2-6, Selecting Fixtures, p. 2-12 for more information on fixture 
selection).

Help menu

The Help menu items include RasterMAPPER Help, Quick Start Guide, About RasterMAPPER.

Selecting RasterMAPPER Help launches a copy of this manual in Adobe Acrobat. In order for 
this to work, RMHelp.pdf file needs to be in the specified location (see RasterMAPPER Help, p. 1-7 
for more detail). You can press F1 (Win) or Cmd+? (Mac) as a shortcut.

About RasterMAPPER displays a dialog box that includes the current RM version number.
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Status Bar

The status bar has three sections:

Left: General information area for minor alerts and notifications.

Center: Pixel Counts - Each port (A through H) shows the number of active pixels. The Total 
shows the total number of active pixels.

Right: Cursor Position – Whenever the cursor is over the work grid in the Pixel Map mode the 
current location is shown here. This is the location of the cursor on the work grid, not the 
computer screen.

Operating Modes 
RasterMAPPER has three different major operating modes: Pixel Map (Pixel Mapping, p. 2-1), 
Programming (Programming Mode, p. 3-1), and Processor Control (Processor Control Mode , 
p. 4-1). These are represented by the three main tabs in the upper left corner (Win) or middle 
(Mac) of the program window.

Work Grid
The Work Grid is the large gray grid area used to build the pixel map in Pixel Map mode and 
display the build/preview the pattern in the Programming mode.

The origin (0,0) of the work grid is the upper left-hand corner. The X axis is horizontal and the Y 
axis is vertical. Positive X and Y values are to the right and below the origin, respectively.

At the default zoom level, each gray square is one work grid pixel and represents one pixel in a 
real Element Labs LED fixture. For example – “Versa TUBE v2 SD 1.0 m” has 16 pixels inside, so it is 
represented by 16 squares on the work grid.

In the Pixel Map mode on the Work Grid toolbar, there are controls for Zoom and Background 
Image. 

The Zoom drop down menu can be used to change from 8% to 800% in seven fixed increments. 
At 100%, each Versa TILE or Versa TUBE pixel is a 5x5 pixel square on the work grid. At 8%, each 
fixture pixel is at a 1 to 1. You also may change the current zoom using the mouse wheel when 
the Hand tool is active.

 is used for building fixtures over existing images. To load a background, click 
on this button and select a graphic file via a standard “open file” dialog box. Once the image is 
loaded, fixtures may be placed over the background. The Background Image can be toggled on 
and off by checking or unchecking the Display Background Image box.

In Programming Mode on the Work Grid Toolbar there are also controls that influence the 
process of exporting the pattern to the video files for preview. (see Programming Mode, p. 3-1 
for details).
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Chapter 2 PIXEL MAPPING
Fixtures

Rectangular fixtures
STEALTH panels, Versa TILEs and rectangular user-defined fixtures (see Custom Fixtures, p. 2-10) 
appear on the work grid as rectangles.

The pixel in the upper left corner of the rectangle is the origin of the fixture, the coordinates of 
the origin are displayed in the Fixture Info tab in the corresponding fields.

Rectangular fixtures cannot be rotated or flipped. The pixel size of the fixture and the size of its 
symbol in RasterMAPPER may be different.

Linear fixtures
Versa TUBEs and other linear, user-defined fixtures (see Custom Fixtures, p. 2-10 for more details) 
appear on the grid with a black dot and an arrow at one end.

The black dot is pixel #1 in the fixture (the input) and is the origin of the fixture.

The arrow clarifies the direction of the data in the tube. The black dot always lands on a pixel in 
the work grid. The number of pixels in the linear fixture and length of its symbol in RM may be 
different.

Origin
RasterMAPPER™ User’s Guide 2-1
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Pixel Map Mode
All processors require a pixel map that defines the relationship of the pixels in your source video 
to the pixels in the fixtures. The Pixel Map mode is used to create this map. Once the map is 
created, it is sent to a D2 processor or saved for future use in the Programming tab to prepare a 
CFF file for a C1 processor.

The Pixel Map mode includes three tabs: Fixture Info, Sequence, and Pixel List. 

Work Grid Tools
To the right of the control tabs are Work Grid tools and the Fixture Select menu:

• Arrow (white) 
The Arrow (white) tool is used for selecting and moving objects.

- When a fixture is selected, the fixture border turns blue.

- Clicking on an empty area of the work grid deselects all fixtures.

• Arrow + (yellow) 
The Arrow + (yellow) tool is used for adding and removing fixtures. (see Adding 
Fixtures, p. 2-5, Deleting Fixtures, p. 2-6 for more information). 

- Right-clicking with this tool prompts you to delete the fixture under cursor.

- Left-clicking adds selected fixture to the grid, if possible.

Also when the Arrow + tool is being used, a floating screen hint appear to the lower 
right of the cursor showing the current location on the work grid.

• Arrow # (green) 
The Arrow # (green) tool is used to address fixtures and re-sequencing.

By default, fixtures are automatically addressed as they are placed on the Work Grid, 
but the addresses can be modified by using this tool. The detailed description is 
given in Modifying a Sequence, p. 2-13.

• Hand 
The Hand tool is used for moving the entire work grid within the window.

• Port 
When the Arrow + (yellow) tool is active, the Port radio group specifies the output 
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port for the fixture being appended. When the Arrow # (green) tool is active, the Port 
radio group specifies the port that is assigned to the fixture being clicked. 

• Fixture
Fixture is a drop down menu that displays standard fixtures (i.e. Versa TILEs/TUBEs/
RAYs/ Helix/STEALTHs...) and user-defined custom fixtures.

• Grid Snap
Grid Snap sets how many pixels a fixture snaps to when placed. By adjusting the 
value and checking the Snap box, fixtures snap to a certain space when placed on the 
work grid. 

• Overlap 
By default, fixtures are not allowed to be placed on top of each other. When the 
Overlap feature is checked, fixtures may be placed on top of each other on the grid 
while adding fixtures.

When Overlap is turned off, fixtures can be dragged over other fixtures while moving 
them, but if you try to place them on another fixture it springs back to its original 
location.

• Show Info
The Show Info check box allows the Port/Sequence and Address information to be 
shown on top of each fixture in the map. It can be turned on and off (see Sequence 
Tab , p. 2-12 for more details on sequences).

At certain zoom levels, some fixtures may be too small to allow the info to be shown 
within the symbol. In those cases, the information is not displayed and you must 
zoom in to a larger view in order for the information to appear.

Standard
Fixtures

Fixtures
User
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Fixture Info Tab 
The Pixel Map section is divided into three areas: Fixture Info, Sequence, and Pixel List. The 
Fixture Info tab is the first step in the process of creating a map. Here you can see information 
about currently selected fixtures or groups.

Fixture Information
The Fixture Info tab displays a fixture’s parameters. Only the Origin and Rotation (for linear 
fixtures) can be edited, the rest of the information is just for reference.

• Fixture Type displays the name for the selected fixture. 
This is useful when many custom fixtures are being used. 

• The coordinates under Origin (X,Y) are automatically 
generated when you place the fixture. They dynamically 
update when the fixture is moved. You can also move the 
fixture by changing the values in these fields.

• Rotation is only used with the Versa TUBEs or custom linear 
fixtures. The number reflects the fixture angle in Cartesian 
degrees measured similar to the angle in standard polar 
coordinates. 

It can be adjusted with the mouse (see Rotating Fixtures — 
Flip, p. 2-7 for details) or directly by entering a new angle in 
the Rotation field.

Note: When a fixture is rotated the pixels no longer fall on 
exact locations in the work grid. The rule for determining 
how to map a rotated fixture is the following: the work grid 
pixel is used that is closest to a pixel in the symbol. The 
exact list of work grid pixels covered by the fixture is 
displayed in the Pixels (X,Y) field.

• Using  button, you can change the ends of linear 
fixtures (see Rotating Fixtures — Flip, p. 2-7 for more 
details).

• Horizontal Pixels and Vertical Pixels define the overall number of pixels in the 
fixture.

• Symbol Width and Symbol Height define the size of the symbol used on the work 
grid. If the symbol height and width are the same as the Horizontal and Vertical Size 
of the fixture, then all the pixels are in one-to-one mapping. If the symbol is of a 
different size than the fixture, certain pixels need to be skipped in the mapping. 

While mapping the following principles are used:

- pixels should be as evenly distributed as possible

- pixels are always distributed in the same way

- skipped pixels are not averaged, they are simply ignored.

• Scan Order defines the order in which the pixels are connected internally in the 
fixture – the order in which they are actually hard-wired.
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• The Pixel (X,Y) list shows the list of mapped pixels for the selected fixture.
This list is the order of the pixels as defined by the Origin (X,Y) values and the Scan 
Order.

N O T E All information in the Fixture Info tab pertains to the currently selected fixtures only. 

If multiple fixtures are selected: the Type field displays “Multiple Fixtures”, all other fields 
contain information on the upper left selected fixture.

• Send Map to Processor (Versa DRIVE D2 only)
When the  button is pressed the following occurs:

1. The Pixel List is created (in the background)
2. A progress box appears that shows the progress of the following three 

steps:
1. RM checks for a current connection to a processor. If there is no con-

nection, it tries to create one. The status is displayed in the progress 
box.

2. After a positive connection is made, RM downloads the Pixel List to 
the processor.

3. When the download is complete (or fails), the progress box shows the 
status.

Pressing the Send button on the Pixel List tab results in the same operations. (See 
Sending the Pixel List to the Processor, p. 2-15 for more details).

Fixture Operations in Pixel Map mode

Adding Fixtures

The Arrow + (yellow)  tool is used to add fixtures to the map. To add a fixture, simply follow 
these steps:

• Choose a fixture from the drop down menu. 

• Move the tool to a position on the grid. An outline of the fixture is visible as an aid in 
placing the fixture. Click to place a fixture. 

If Overlap is turned off, the outline turns red when the fixture is overlapping an 
existing fixture – indicating that you cannot place a new fixture there.

• An icon representing the fixture appears on the grid and information relating to that 
fixture appears on the left hand sidebar of the Fixture Info tab.

• If a fixture is placed that has more pixels than are available in the current port, it is 
placed in the beginning of the next port.

- When this happens, the radio button automatically changes to reflect the new 
port.

- If there is not enough room left on any port, the dialog box warns you that it is not 
possible to place this fixture.
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Deleting Fixtures
To Delete a fixture from a map, select the Arrow + tool and right-click on the fixture. A prompt 
appears asking you if you wish to delete the fixture. Select “Yes” to delete.

Also, a selected fixture, or multiple fixtures are deleted by using the Delete key or choosing 
Clear from the Edit menu. The same dialog box appears.

N O T E When a fixture is deleted, the remaining fixtures on that port are re-sequenced to fill in the 
numerical gaps in the sequence. The remaining fixtures are NOT physically moved on the map. 
Fixtures on other ports remain unaffected.

Selecting/Deselecting fixtures
The following ways may be used to select one or multiple fixtures, both in the list (in the 
Sequence tab) and on the work grid:

• Shift + Click for multiple fixtures in a series

• Ctrl + Click for multiple, non-sequential fixtures

• Press Ctrl + A (Win) or Cmd + A (Mac) to select all of the fixtures on the map

• Draw a bounding box with the arrow cursor

Selecting one or more fixtures on the work grid also highlights these fixtures in blue in the 
Sequence list. See Selecting Fixtures, p. 2-12 for more details on fixture selection in the 
Sequence list.

If the cursor’s focus is on the workgrid and no fixture is currently selected, pressing any of the 
four arrow keys on the keyboard selects the nearest fixture in the corresponding direction.

If there are selected fixtures, clicking with the arrow tool in an arbitrary free place on the work 
grid deselects all the fixtures.

If a fixture is selected, and that fixture is a part of a group, the entire group is selected. See 
Grouping/Ungrouping fixtures, p. 2-7 for more details.

Moving Fixtures
Using the Arrow tool, click and drag to move the selected fixtures to the desired location.

If a single fixture is selected, it is moved using the Origin (X,Y) fields in the Fixture Info tab. 
Enter X,Y values directly into these fields and press Enter or Tab.

The selected fixture may be nudged in 1 pixel increments using the keyboard arrows. 
RasterMAPPER™ User’s Guide 2-6



 Chapter 2
Pixel Mapping
Rotating Fixtures — Flip
Only Linear fixtures may be rotated/flipped. To do this, Ctrl-Click (Win), Cmd + Click (Mac) 
the linear fixture and drag on the cursor.

You can also use the Rotation field in the Fixture Info tab. When a linear fixture is rotated, the 
black tip (pixel #1) is the anchor point.

The Flip button flips a linear fixture 180° (exchanges the position of the black dot) so that the 
data is running through the fixture in the opposite direction. 

• Normal Fixture: 

• Flipped Fixture: 

N O T E The position of the linear fixture on the work grid may change after flip, because the fixture 
origin must always be located over a Work Grid pixel.

If you selected multiple linear fixtures, you can rotate them to the equal angle with 
Ctrl-Click (Win), Cmd+ Click (Mac) on one of the linear fixtures or using the Rotation field 
on the Fixture Info tab.

While moving several selected fixtures (if the move was started by clicking on the linear fixture) 
you can also rotate them before dropping on the work grid using Ctrl-Click (Cmd+ Click 
Mac) or by using mouse wheel. 

N O T E Grouped fixtures may not be rotated.

Grouping/Ungrouping fixtures
Multiple selected fixtures can be combined into a group for easy moving, copying, etc.

Individual fixtures and groups can be combined into another larger group (nested). Any fixture 
can belong to only one group at a time. If a fixture is selected, and that fixture is part of a group, 
the entire group is selected.

Operations performed on a group work the same as if all of the individual fixtures in that group 
were selected together (i.e. – as if they were all selected but not part of a group). 

Grouped fixtures may not be rotated.

To group several fixtures,

1. Select the fixtures
2. Press Ctrl+G (Cmd+G) or use the Group item from the Edit Menu.

To ungroup fixtures,

1. Select the group
2. Press Ctrl+U (Cmd+U) or use the Ungroup item from the Edit menu.
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Cut/Copy/Paste Fixtures
Standard OS conventions are used for Cut, Copy, Paste on either single fixtures, multiple 
fixtures, or groups. 

When a fixture is Cut, the sequence is modified according to the same rules as if it was deleted. 
(see Deleting Fixtures, p. 2-6 for details).

When a fixture is Pasted, the sequence is modified in the same way as if a fixture was inserted 
into a new location (see Adding Fixtures, p. 2-5 for details).

If the fixture was cut/copied and then the corresponding fixture type was deleted, pasting this 
fixture adds its type to the list.

Duplicating Fixtures
Duplicate makes a copy of the selected fixture(s) and assigns the next available sequence 
numbers. The newly created, duplicate fixtures are created in the first available free space to the 
right of the original fixture. If there is no space to the right, then it is created below. If there is no 
space below, then it is created in an arbitrary available free place.

If there is not enough available space to create the new fixtures, a warning dialog appears and 
the Duplicate operation is cancelled.

After duplication, the newly created fixtures are selected and the original fixtures are deselected.

To duplicate a fixture, select it and press Ctrl+D (Cmd+D) or use the Duplicate item in the Edit 
menu. 

Duplicate Array
Using Duplicate Array functionality, you can create several copies of the selected fixture that are 
placed according to one of three algorithms

1. Linear array
2. Rectangular array
3. Circular array.

Linear array places the specified number of copies of the selected fixture on the Work grid. The 
duplicates are placed at the specified X and Y steps from each other and the original fixture.

Rectangular array places the specified number of copies of the selected fixture on the Work 
grid. The duplicates are placed in rows and columns at the specified X and Y steps from each 
other.

Circular array places the specified number of copies of the selected fixture along the circle with 
the specified center at the specified angles.
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For all 3 algorithms, the following is true:

• If there is not enough available space to create the new fixtures a warning dialog 
appears and the operation is cancelled.

• The newly created fixtures are selected and the originals are deselected.

• If “Grid Snap” is enabled, then the newly created fixtures are placed according to the 
current Grid Snap spacing.

To start any of three algorithms, 

1. Select a fixture to be duplicated
2. Press Ctrl+Shift+D (Cmd+Shift+D under Mac OS X) or use Duplicate Array item 

from the Edit menu. This brings up the dialog box below.

3. Select the desired algorithm.
4. Enter the parameters of the algorithm (X and Y coordinates follow the work grid conven-

tions where positive Y values go down; angle values are Cartesian) The Rotate duplicate 
box allows rotation of the duplicates to the specified angle if the duplicates may be 
rotated. 
Note: For the Circular Array the Offset fields changes to Center and corresponds to the 
absolute coordinates of the circle center (the circle radius is determined by the position 
of the initial fixture).

5. Click OK. If the duplicated fixture can not be placed on the Work Grid the corresponding 
Dialog box appears.
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Custom Fixtures
The Edit/Add… option in the Fixture drop down list allows you to modify or create a fixture. It 
brings up the following dialog box:

Adding/Modifying Custom Fixtures
The  and  buttons bring up the following dialog boxes which is used to 
create new fixtures:

The same dialog appears when clicking  button and when rectangular or linear fixture 
is selected. 
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• A Name can be entered for unique fixtures. It can not be modified for default and 
user fixtures.

• Horizontal and Vertical Pixels (rectangular fixtures) or Pixels (linear fixtures) is used 
to define the number of actual pixels in the fixture.

• Symbol Width and Symbol Height (rectangular fixtures) or Symbol Length (linear 
fixtures) is used to define the size of the fixture symbol in RasterMAPPER.

• Scan Order defines the direction and order in which the pixels are connected in the 
fixture. Clicking on this button brings the following menu from where the fixture scan 
order is selected.

• Color is used to distinguish between two similar looking fixtures within a map. The 
color button brings up the standard OS color picker dialog.

Deleting Fixtures
Only user defined fixtures may be deleted from within RM.

Delete a fixture type by selecting the fixture title from the menu and pressing the  
button.

N O T E You cannot delete a fixture type if there are fixtures of this type on the Work Grid.
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Sequence Tab 
As fixtures are placed on the work grid, RM automatically assigns them a Port/Sequence 
number. The Port is determined by which port is selected in the radio buttons on the toolbar (A, 
B, C, D, E, F, G or H, depending on the processor). Sequence is simply a numerical order starting 
at 1 for each port. The Port/Sequence info looks like this: A1, A2, B18, etc…

Show Info check box on the toolbar toggles on and off labels on each fixture that display the 
current Port/Sequence info. Hovering over any fixture in the work grid for more than one 
second displays the screen hint with the fixture’s Port/Sequence and Address.

If a fixture is placed that has more pixels than are available in the current port, it is placed in the 
beginning of the next port. When this happens, the radio button automatically changes to 
reflect the new port. If there is not enough room left on any port, a dialog box warns you that it is 
not possible to place this fixture.

N O T E It is possible to manually specify the Port and the Sequence number as described in Modifying a 
Sequence, (p. 2-13).

The Port/Sequence information is shown in the Sequence tab:

• Clear Selection clears the sequence information for any 
selected fixtures.

When a fixture has its sequence information cleared, the 
color of the fixture’s symbol color changes to red to show 
that there is no sequence.

• The Address column is automatically filled in by 
RasterMAPPER. The address of a fixture is the number of its 
first pixel. It is calculated by adding up the size of all the 
fixtures before it on that port. The address numbering always 
starts at 1 for the first fixture on each port.

Selecting Fixtures
Selecting a fixture on the work grid also highlights that fixture in the Sequence List. 

While the information in the Sequence List cannot be modified directly in the list, the list may 
be used to select fixtures – i.e. selecting a fixture in the list also selects and highlights the same 
fixture on the work grid.

If the cursor’s focus is on the Sequence List, then the up and down arrow keys on the keyboard 
select the next fixture up or down in the list.
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Creating a Sequence from Scratch
Often, it is convenient to clear all of the existing sequence information and start from scratch. 
There are a number of options to assign new sequence numbers. After clearing all (or some) of 
the sequence info:

1. Use the Arrow #  tool to click on the fixtures in the order that you want them 
sequenced. They are assigned in numerical order (1, 2, 3, 4,) on the port that is currently 
selected on the tool bar radio buttons. If there are already other fixtures with sequence 
numbers, the sequencing starts on the next available number on that port.

2. Use the Arrow #  tool to click and drag over a series of fixture. When the mouse is 
released all of the fixtures that were covered by the bounding box are automatically 
numbered in sequence starting with the next available sequence number.

- If the bounding box includes only a single row (X axis) or column (Y axis) of 
fixtures, the fixture that is first clicked on is the lowest number and the fixture that 
the mouse is released on is the highest numbered fixture.

- If the bounding box includes an array of fixtures in both axis, then they are 
assigned sequence numbers in any of the following orders, depending on the 
bounding box proportions and Mouse Down / Up coordinates. In the following 
examples Green = Mouse Down and Red = Mouse Up.

N O T E Whenever an unsequenced fixture is assigned a sequence number, its symbol color reverts to its 
normal color. Immediately after having a new sequence number assigned to it, the fixture’s 
border is blue.

Modifying a Sequence
The sequence determines the order of the pixels output from the processor. Individual fixtures 
are assigned an address as they are added to the grid. But the sequence may be changed after 
the fixtures have been placed on the work grid.

To change the address of one fixture, select the Arrow # tool and right-click on the fixture you 
want to change. The following dialog appears:
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Changing a sequence number of an existing fixture usually affects other fixtures. There are two 
choices to determine what happens:

• Shift Up/Down – the newly sequenced fixture is “inserted” into its new sequence 
location and all of the other fixtures between the two locations are shifted up or 
down one position.

• Swap – the newly sequenced fixture replaces a fixture that already had that port/
sequence information. The replaced fixture is re-assigned to the old location.

Pixel List Tab
Once the map has been created and the sequence defined, this information is used to generate 
a Pixel List, which is then sent to the processor. This is done in the Pixel List tab:

• Pixel List
When the Pixel List mode is selected the coordinates of all 
the fixtures in the map are collected in a single list.

• Send button
Send the current pixel list to the processor by clicking the 
Send button. See Sending the Pixel List to the Processor, 
p. 2-15 below for more details).

• Get button
Receive the pixel list from the processor by clicking the 
Get button. See Retrieving the Pixel List from the 
Processor, p. 2-16 below for more details.

• Save List button
Once a Pixel List has been created or downloaded from a 
D2, it can be saved into *.LST file.

• Open List button
This opens an existing *.LST file and loads it into the Pixel 
List tab. 

• Front/Rear view switch
Since most the technical work in setting up a system is 
performed from the rear of the system a pair of radio buttons is implemented that 
allows the view to be changed from “Front” view to “Rear” view.

The screenshots below show the map in ‘Front View’ (left) and “Rear View” (right).
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Sending the Pixel List to the Processor
To send the current pixel list to Versa DRIVE D2:

• Connect your computer to the processor using the Processor Control tab settings 
(see Processor Control Mode , p. 4-1).

• Press the  button in the Pixel List tab to transfer your map to the processor via 
the RS232 connection. This process typically takes a few seconds – large maps can 
take longer. During this process, a dialog appears as follows:

When the transfer completes successfully, the following dialog box is displayed:

During transfer you can cancel it by clicking on Cancel button:

When the operation is canceled, the following dialog box is displayed:

The same dialog box is displayed if you do not have any processor connected.

It is possible to verify that the correct data has been sent using the  button in the Pixel 
Count section of the Processor Control mode. This number should be the same as the total 
number of pixels that you sent to the processor.
RasterMAPPER™ User’s Guide 2-15



 Chapter 2
Pixel Mapping
Retrieving the Pixel List from the Processor
The  button retrieves the current Pixel List from a connected D2 processor and is shown 
in the list area of the Pixel List tab.

N O T E Getting a list from the processor does not re-create the original map. The map is filled with 
individual pixels. It is not possible to recreate the original map without a .MAP file.

When using the  button, RM asks you if you want to save changes to the current map 
(.MAP file) and then clear the current map before downloading the new Pixel List from the D2. 
This avoids any confusion between a map and pixel list that do not match. During the “get” 
process you see progress bar of operation.

Saving/opening .LST files
The current pixel list may be saved using Save List button to the tab-delimited .LST file, that 
later may be opened using Open List button and its data be imported to the Pixel List.

N O T E The structure (type and position of the fixtures) of the current map is not saved in the .LST file 
and it is not restored when the .LST file is opened.
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Chapter 3 PROGRAMMING MODE
Overview

The Programming mode is used for creating patterns for the C1 controller and AVI files for D2 
controllers. The C1 does not have an internal video processor, or a video input, so the video file 
and the map information are combined within RM to create a .CFF file that is used by the C1.

N O T E S The C1 Processor can only use 1024 or 2048 pixels max.
Before using the Programming Mode, you must create a map in the Pixel Map tab. See Ch. 2: 
Pixel Mapping (p. 2-1), for more information.
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Programming Tab

• Add Button
Press the Add button and a standard OS Open File 
dialog box appears. You can import either picture files 
(individual frames of varying formats) or movies.

Note: The compressed/encoded video files (AVI, MOV, 
MPEG etc.) may be imported only if the appropriate 
codec is installed on the computer.
You can import several files at a time. Each imported file 
appears as a single item in the Frame List, i.e. pictures 
(BMPs or others) appears individually in the Frame List, 
video and picture files appear in the Frame List as a 
single item.
Note: If the imported frame dimensions are larger than 
the existing map dimensions, any extra pixels are 
disregarded. If the imported frame is smaller than the 
map, the extra mapped pixels are black for that frame. 
The imported image is NOT scaled to fit the map.
If there are existing frames in the list, the   
button appends the new files to the end of the list.

• The  button inserts any new frame(s) before 
the currently selected frame.

• The  button deletes any currently selected 
frames.

• The  button deletes everything in the Frame List.

• At the bottom of the tab there are standard transport controls:

From left to right these controls are:

-  Go to the beginning and pause

-  Play from the beginning 

-  Play from the current location 

-  Stop in the current location (the Esc keyboard button may be also used)

-  Go to the next item in the list and pause

The playback head ( ) on top of the progress bar can be moved with the mouse to 
rapidly shuffle back and forth through the movie.

The Pattern playback is at 30 fps regardless of the initial fps of the imported files.

When the pattern is stopped, selecting any item in the list displays that Item in the 
work grid. If a media file item is selected, its first frame is displayed.
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• There are 6 lines of information about the current pattern displayed at the bottom of 
the tab:

List items equals the number of line items in the pattern list (each media file is 
represented with one list item)
Frames equals number of each individual video frame. A BMP is 1 frame. An AVI is 
usually multiple frames.

Operations in Programming mode

Creating/Editing a Pattern
The pattern may be created or edited using the Add, Insert, Delete, and Delete All buttons 
described above.

Exporting a CFF File
When a pattern is complete, it may be exported to a .CFF file (this is the format that is required 
on the Compact Flash card by the Versa DRIVE C1)

To export a pattern to .CFF:

1. Click  button to create a .CFF file.
2. The standard OS “Save File” dialog appears. Name the file, choose the location, and click 

Save.

N O T E The first three characters must be digits 001 through 253 (corresponding to the desired pattern 
number) for the file to work properly on the C1. The rest of the characters can be anything. For 
example: 017redstripes.cff
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3. The following dialog box appears. In this dialog you can specify the file header informa-
tion:

4. Click OK to close the dialog box.

Exporting a Video File
The purpose of exporting a video file is to create a preview movie of the pattern (for client 
presentations, etc.). 

You can specify the desired area that is exported by dragging a box around it using the right 
button of the mouse. You can reset the rounding box to the whole map by clicking on the Reset 
button in the Work Grid toolbar.

By default, the selected area is exported in one-to-one mapping (8% zoom). If the 
Export AVI using the same zoom box is selected, the selected area is exported as it is displayed 
in the workgrid.

To export an AVI file:

1. Select the desired area for export

2. Click  button. This displays the OS standard ‘Save File’ dialog.
3. Name the file and click Save.
4. The following dialog box appears, where you can select the compression options of the 

file to be exported.

5. Click OK.
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Saving/Opening .PTN Files
• In the Programming Mode, the Pattern List can be saved as a .PTN file.

• Existing .PTN files are opened instead of importing new frames with the Add or Insert 
buttons.

• .PTN files are completely independent of .MAP files. So after a .PTN file is created or 
opened, you can open or create a different .MAP file for use with the existing .PTN file.
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Chapter 4 PROCESSOR CONTROL MODE 
Overview

This mode provides control over many of the Versa DRIVE D2 Processor’s parameters. Values set 

in the various boxes are sent to the Processor using the  button or retrieved by using 

the  button.

While in the Processor Control Mode, the file Open and Save buttons are used for .VDC files only. 
The .VDC file only saves the information in the “Connection Settings” and “Output” areas.
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Connection Settings
• The Serial Port should be set to whatever port you 

are using on your computer, usually COM1.

• The Baud Rate should be set to 19200. Other speeds 
are not currently supported.

• Connect button. To connect to the Processor, set the 
port accordingly and press the Connect button.

If the selected port is not available, a dialog box 
appears stating “Open COM PORT failed.” If the 
selected port is available, it is displayed in the status 
bar at the bottom of the program window.

RM checks for the valid communication to and from 
the D2 before indicating a positive connection. If the 
test passed OK, then RM displays “connected” in the 
Status Bar. If the connection test failed, RM displays a 
dialog stating whether the failure was in the 
computer (i.e. com port not available, etc.) or in the 
connection with the D2 itself (i.e. processor not 
responding).

• Processor Model
Select which Processor Model is receiving your map: D1 or D2. 

• Processor Select
RS485 communication with the D2 allows up to 32 D2s to be connected together. 

If using RS232, you must select Processor #1 in order to communicate with it. 
(assuming the ID on that Processor is set to #1). The default is for only #1 to be 
selected.

• Group Select
Processors can be divided into groups to aid in larger installations. To group the 
Processors:

1. Click on the drive numbers to group.
2. Choose a Group Select letter.
3. Press the Store Group button.
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Information

When you press the  button, the D2 returns the Firmware 
Version, the Firmware version date and total Pixel count.

Pixel Count is the number of pixels in the Processors current Pixel 
List. It’s a quick way to confirm that you have sent the correct size 
Pixel List to the Processor.

Output 
Video, Static Test Patterns, and Dynamic Test Patterns switch the D2’s output among the 
following choices:

• Video selects the DVI input on the D2.

• Static Test Patterns include static patterns. 

• Dynamic Test Patterns are moving test patterns that 
are useful when testing individual pixels on a Processor 
panel. The two Dynamic Test Patterns can only be used 
with the D2 Processor. 

All 13 buttons for the above options are mutually exclusive. You 
can only select one at a time. When an output button is pressed, 
the command is immediately sent to the Processor (there is no 
need for a  button)

• Horizontal offset, Vertical offset
The image Horizontal offset and Vertical offset values 
shift the entire map horizontally and vertically. The 
screen origin is at the upper left hand corner. Positive 
Horizontal offset values shift the map to the right. 
Positive Vertical offset values shift the map down.

Since the Image Offset can be set independently via 
the front panel of the D2, there is the  button 
to retrieve the current values from the D2.

The  and  buttons below the Image 
Offset fields apply only to the image offset parameters.

• Brightness
Sets the output level of the D2 on a scale from 1 to 10.

Since the Brightness can be set independently via the front panel of the D2, there is a 
 button to retrieve the current value from the D2.

The  and  buttons below the Brightness field only apply to the 
image offset parameters.
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Group White Balance
The Group White Balance values are downloaded into a lookup table on the D2. These are 
individual Red, Blue, and Green scaling factors that are applied to every pixel (or groups of 
pixels) before they are sent out of the D2. By default, these values are set at 63 (on a scale of 0 to 
63) which allow each pixel to be its full brightness.

However, it is often necessary to adjust the individual output of some or all of the colors in a 
pixel or group of pixels.

• The table works just like an ordinary 
spreadsheet. You can:

- Type values into each field

- “Tab” to the next cell

- “Enter” to complete an entry but 
stay in that cell

- Navigate using the keyboard 
arrow keys (assuming the cursor’s 
focus is in the table)

• The   button clears the 
entire table. There should be a 
warning dialog with this action.

• The Global Offset fields are values 
that are added or subtracted from all 
the values in the table before it is 
sent out to the D2. 

• Global Offsets can range from -63 to 
+63

• Values are “capped” at 0 and 63. If the 
sum of pixels values from the table 
plus the Global Offset is greater than 
63 then the value is set to 63 by 
definition. Likewise if it falls below 0.

• The  button is used to load the current GWB list from the D2 into the table. A 
warning dialog will appear first asking if you want to save the current GWB 
information before it is overwritten.

• Save List button
Once a GWB List has been created or downloaded from a D2, it can be saved as a 
tab-delimited text file. This file will be automatically appended with a .GWB suffix so 
that they can be easily identified.

• Open List button 
This opens an existing tab-delimited text file (with the .GWB suffix) and loads it into 
the GWB table.
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